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CLASSIC MIDI KEYBOARD 
CMK-2 

 

1. LIMITED WARRANTY  
 
 
Classic Organ Works warrants the Classic MIDI 
Keyboard (CMK-2) to be free from defects in 
materials and workmanship under normal use for a 
period of ONE YEAR from the delivery date. 
This warranty applies only if the original 
purchaser who has the bill of sale owns the 
product.  
 
This warranty explicitly excludes any cables 
provided with the CMK-2, which may become 
defective because of normal wear and tear. The 
DC power adaptor is included in the warranty 
however.  
 
As soon as a defect is detected, contact Classic 
Organ Works. In particular, defects due to 
shipping should be reported within 5 days for 
insurance claim purposes. For all other defects, 
Classic Organ Works agrees to repair or replace 
all defective parts of said products, which are 
returned, transportation prepaid, for inspection at 
its service centre within the period of the 
warranty. 
 
In the event that Classic Organ Works 
determines the product requires repair because of 
user misuse or regular wear, it will assess a fair 
repair or replacement fee. The customer will have 
the option to pay this fee and have the unit 
repaired and returned, or not pay this fee and have 
the unit returned un-repaired. 
 

 
Classic Organ Works will not be liable for 
consequential, special, indirect, or similar 
damages or claims including loss of profit or any 
other commercial damage, and in no event will 
Classic Organ Works’ liability for any damages 
to the purchaser or any other person exceed the 
price paid for the product, regardless of any form 
of the claim.  
 
Classic Organ Works specifically disclaims all 
other warranties, expressed or implied. 
Specifically, Classic Organ Works makes no 
warranty that the product is fit for any particular 
purpose. 
 
This warranty shall be interpreted, and governed 
by applicable laws in the province of Ontario, 
Canada. If any provision of this warranty is found 
void, invalid or unenforceable, it will not affect 
the validity of the balance of the warranty, which 
shall remain valid and enforceable according to its 
terms. In the event any remedy hereunder is 
determined to have failed of its essential purpose, 
all limitations of liability and exclusion of 
damages set forth herein shall remain in full force 
and effect.  
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CLASSIC MIDI KEYBOARD 
CMK-2-1 

2. INTRODUCTION  
Description  
 
The CMK-2 is a MIDI keyboard controller designed for the modern organist. It combines technology and 
classical church organ ideas into an innovative MIDI device. 
 
The keyboard features: 

• Tracker organ style key action 
• User-programmable pistons 
• A stacking mechanism for mounting multiple manuals in a traditional organ configuration 
• Inputs for expression shoes 
• Velocity sensitive (optional) 

 
With the CMK-2, MIDI software and sound modules may be controlled as if they were part of the organ. The 
CMK-2 is designed to work with all of your favorite hardware and software, including: 

• Crumhorn Labs’ Hauptwerk virtual organ software 
• Ahlborn-Galanti’s Archive MIDI sound modules 
• MidiTzer virtual organ software 
• Products capable of being controlled by standard MIDI messages 

 
Enjoy your new CMK-2! 
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Package Contents  
 

Table 1: Package Contents  
  

Items Setup 
Manual(s) Stacking Bracket DC Adapter MIDI Cable(s) 

1 Manual 1 2 x B 1 1 
2 Manual 2 2 x B + 2 x C 1 2 
3 Manual 3 2 x B + 4 x C 1 3 
4 Manual 4 2 x B + 6 x C 1 * 4 

 
 

 
 
    
  

  
 A B C  
 

      
 
 D E  F  

 

Figure 1: CMK-2 components:  
 
  A) Keyboard  
  B) Fatar small mounting bracket  
  C) Fatar large mounting bracket  
  D) 9 to 12V DC wall adaptor  
  E) 6-Ft. MIDI cable  
  F) Mounting screw.  
 

* Adaptor is 9V 1A for four keyboards. Normal one is 500 mA. 
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Figure 2: CMK-2 connections 
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CLASSIC MIDI KEYBOARD 
CMK-2-1 

3. INSTALLATION  
 

IMPORTANT 
READ THIS DOCUMENT BEFORE INSTALLATION 

 
Upon receiving this unit, remove any packing material inside the unit that may have been included to 

prevent movement of components or wiring during shipping. 
(For internal access, ensure the unit is disconnected from all power sources.) 

 

Physical Installation  
 
The CMK-2 can be mounted into a traditional organ console or set on a table. The American Guild of Organists’ 
Standard Dimensions states that the top of the lowest manual’s keys must be 29.5" from the top of the E and F pedals. 
If the standard Classic MIDI Pedalboard is used, the table will then be 32.5" from the floor. 
 
 

 
 

Figure 3: Bracket Installation  
 

 
 

Figure 4: Bracket Goes above Keyboard Mount  
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First, note that the topmost keyboard should have the two shortest brackets. Then, sit the plastic supports on the end of 
each keyboard (Figure 4) and fasten them in place with three #8 screws from underneath (Figure 5). Stack the 
keyboards by sliding the slots on the upper supports over the pins on the lower supports. To slide the upper supports 
into place, first tilt the keyboard up about 30 degrees. At that angle, the pins on the lower supports will slide through 
the slots on the upper supports. 
 
 

 

Figure 5: Install three #8 Screws in the Underside  

Connectors  
 

MIDI OUTMIDI OUT MIDI OUTMIDI INDC 12V INPUT 3 INPUT 2 INPUT 1
HEARTBEAT

LIGHT

+   O   - +   O   - +   O   -

not used

Swell-shoe input for Ahlborn 
Archive crescendo pedal

Standard swell-shoe input parallel outputs (all the same)

GND

+12V

MIDI OUT

POWER
TERMINAL 

BLOCK

AB BA

 
 

Figure 6: Rear View Connections  



MIDI KEYBOARD CMK-2 INSTALLATION MANUAL v1.5 
 

  

CMK-2 Manual 1.5.doc 2009 CLASSIC ORGAN WORKS 13 

Power Connections  
 
If you are using multiple keyboards, connect the red and black wires as illustrated in the diagram below (to parallel the 
boards) and then connect the supplied DC power supply to the co-axial power connector on one board. The power 
supply can be plugged into any one of the manuals. Make sure that you use red wires for the +12V (A terminals) and 
black wires for the Ground (B terminals). 
 
If you have a stack of four keyboards, you may use one power supply of 1 Amp capacity or two of 500 mA. If the 
latter, parallel only two keyboards per power supply. 
 
When the keyboard is powered and operating, the green ‘Heartbeat’ LED between the MIDI IN and MIDI OUT 
connectors will be flashing. 
 
 

DC 12V

POWER
TERMINAL 

BLOCK

A AB B

A AB B

A AB B

DC POWER
SUPPLY

 
 

Figure 7: Power Terminal Block Connections  
 
Additional Information: 

• If the CMK-2 is to be mounted in an existing organ, it can be connected to the organ power supply. See 
Figure-33 in Appendix-C for details. 

• The CMK-2 has a bridge-rectifier, and can accept power supplies with either positive or negative on the centre 
pin of the 2.1mm (0.080") Co-axial Power Jack. 

• The CMK-2 requires between +9V and +15V DC at a minimum current of 120 mA per board. The supplied 
power supply (500 mA) is good for up to three keyboards. One with more current capability (typically 1 Amp) 
should be used for four keyboards, or else use two smaller power supplies for two keyboards each. 

• A 500mA self-resetting Polyfuse on each board provides over-current protection. 
.  
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MIDI Connections  
 

MIDI OUTMIDI IN

Classic MIDI Pedalboard
(rear view)

MIDI IN MIDI OUT

MIDI Adapter

Connected
to PC

Ahlborn Archive and 
other MIDI Modules

MIDI OUTMIDI OUTMIDI OUT MIDI OUTMIDI IN

MIDI OUTMIDI OUTMIDI OUT MIDI OUTMIDI IN

MIDI OUTMIDI OUTMIDI OUT MIDI OUTMIDI IN

Manual 1

Manual 2

Manual 3

 
 

Figure 8: Connecting Cables to a Keyboard Stack  
 
Note: If you have more keyboards, they should be ‘daisy-chained’ in a similar manner at the bottom of the stack so 
that #1(the top one) is always the first one connected to MIDI OUT on the computer (via the pedalboard if there is 
one). 
 
The MIDI OUT cable from the computer/adaptor is needed only during configuration. It should be unplugged during 
normal use. 
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Connecting Swell Shoes  
There are three terminal-blocks for analog inputs. Analog inputs are used for crescendo and volume/expression 
adjustments. Schematics for analog and expression pedal inputs are shown below. 
 
 

 

Figure 9 Wiring Schematic for Analog inputs  
 
The +5V and Ground are supplied by the CMK board. Ensure that the slider is the centre pin of the three. Then the 
control can be easily reversed if necessary. 
 
Analog Inputs 1 to 3 can be used for any kind of analog input control and configured by the CMK-2 Config software 
or the setup key sequence described in the Programming sections 5 and 6. The +5V is supplied by the CMK-2. 

Table 2: Connection Chart 
 

Connection Name Connection Type Hardware Description 
Required Connections: 

Power Input 1. Co-ax 2.1mm (either polarity) 
OR 

2. 4-input Terminal Block 
 Input 1 for +12V, Input 2 for GND 

9-12V, 120mA minimum 
Per CMK-2. 

Loop through to other 
CMK-2s. 

 
MIDI IN Input DIN 5-pin socket 180° Standard MIDI signals 

MIDI OUT 1-4 Output DIN 5-pin socket 180° Standard MIDI signals 
Optional Connections: 

Analog 
JP-1, 5, 8 

Input 3-input terminal blocks 
Screw terminals 

Three inputs available. 
+5V and 0V provided by 

the CMK-2 
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Software Installation (Windows1 and MacIntosh users2)  
 
Software installation instructions are described in the ‘CMK Configuration Software’ section of the manual, and under 
the Help menu of that software (Windows only).  
 
Note: To use the software, the CMK-2 must be connected to a computer via MIDI. If a MIDI port is not available on 
your computer, a commercial MIDI adapter for the game port, USB port, or parallel port may be used. A suitable one 
is the M-Audio MIDIman 1x1 that comes with both Windows and MacIntosh drivers. 

 

                                                           
1 Windows is a registered Trademark of the Microsoft Corporation. 
2 MacIntosh is a registered Trademark of Apple Computer Corporation. 
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CLASSIC MIDI KEYBOARD 
CMK-2-1 

 
4. MIDI SPECIFICATION  

 
 
MIDI (Music Instrument Digital Interface) is a communication system between computer-controlled music 
instruments and describes all the actions of a musical performance. It was originally developed for music synthesizers 
but, a few years ago, organ-builders began adding MIDI capabilities to pipe organs. However, as MIDI was not 
designed for a complex musical instrument such as the organ, its standards are subject to organ-builders preferences.  
 
MIDI is composed of three components which are the language (protocol), hardware (MIDI connector), and 
distribution format (MIDI file)[1]. The MIDI language is in binary format and is a uni-directional asynchronous stream 
of bits at 31.25 KBits per second with 10 bits transmitted per byte. The 10 bits per byte consist of a start bit, 8 data 
bits, and a stop bit. In the hardware domain, the MIDI 1.0 Specification (maintained by the MIDI Manufacturers 
Association) recommends the 5-pin DIN 180° connector. The 5-pin DIN connector is standard and allows MIDI 
equipment from differing manufacturers to be connected together. MIDI cables transmit information in a uni-
directional manner so connectors are designated as either input or output. MIDI files are the standard distribution 
format. They capture all the details of MIDI onto a hardcopy medium. MIDI files are similar to the MIDI language 
except that they add a time-stamp for each event so that MIDI equipment can replicate the timing required to generate 
accurate performances. MIDI Message information can be found at www.midi.org.  
 
The standard MIDI sounds available with General MIDI are listed in Appendix-F. 
 
 
Ahlborn[2]:  
The Ahlborn Archive modules allow additional pipe organ sounds to be played on an existing organ. There are four 
separate Ahlborn Archive modules of 20 different stops each over three separate divisions. For more information on 
Ahlborn Archive modules, please visit: http://www.ahlbornorgans.com/archive. The messages for controlling Ahlborn 
Archive modules can be found in Appendix D. The stop list for each module is shown below. 
  

Table 3: Classic Module[3] 
 

Division A Division B Pedal 
Description Description Description 
Gemshorn 8' Principal 8' Contre Basse 32' 

Gemshorn Celeste 8' Holzgedackt 8' Contre Gambe 16' 
Flûte à cheminée 8' Flûte Harmonique 8' Contre Bombarde 32' 

Koppelflöte 4' Flûte Octaviante 4' Bombarde 16' 
Plein Jeu IV-V Octave 2' Div. A to Ped. 
Bombarde 16' Cymbale III Div. B to Ped. 

Harmonic Trumpet 8' Tremulant  
Corno di Bassetto 8' Div. A to Div. B  
Festival Trumpet 8'   

Clarion 4'   
Tremulant   

Div. B to Div. A   
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Table 4: Romantic Module[3]  
 

Division A Division B Pedal 
Description Description Description 

Cello 8' Open Diapason 8' Contre Violone 32' 
Cello Celeste 8' Flauto Mirabilis 8' Contre Gambe 16' 

Cornet des Bombardes IV Concert Flute 4' Contre Bassoon 32' 
Cornopean 16' Quint Flute 2 2/3' Ophicleide 16' 

Clarinet 8' Piccolo 2' Div. A to Ped. 
Orchestral Oboe 8' Vox Humana 8' Div. B to Ped. 

French Horn 8' Tremulant  
Cor Anglais 8' Div. A to Div. B  

Tuba Mirabilis 8'   
Clarion 4'   
Tremulant   

Div. B to Div. A   
 

Table 5: 201 Module[3]  
 

Division A Division B Pedal 
Description Description Description 
Bourdon 16' Gedackt 8' Subbass 16' 
Principal 8' Gamba 8' Octave 8' 

Flûte à cheminée 8' Nachthorn 4' Bourdon 8' 
Unda Maris 8' Cymbale III Posaune 16' 

Octave 4' Cornet III Div. A to Ped. 
Spitzflöte 2' Oboe 8' Div. B to Ped. 
Nasard 2 2/3' Tremulant  

Superoctave 2' Div. A to Div. B  
Mixture IV   
Trompete 8'   
Tremulant   

Div. B to Div. A   
 

Table 6: 202 Module[3]  
 

Division A Division B Pedal 
Description Description Description 

Contregambe 16' Bourdon 8' Soubasse 32' 
Diapason 8' Flûte harmonique 8' Violone 16' 

Quintadena 8' Flûte octaviante 4' Contrebombarde 32' 
Terz 1 3/5' Larigot 1 1/3' Bombarde 16' 

Septime 1 1/7' Corno di bassetto 8' Div. A to Ped. 
Scharff III Clarion 4' Div. B to Ped. 

Bombarde 16' Tremulant  
Trompette 8' Div. A to Div. B  

Tuba Mirabilis 8'   
Chimes   

Tremulant   
Div. B to Div. A   
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HAUPTWERK IITM [4]  
 
The CMK-2 provides an interface for volume controls, expression controls, and pistons. MIDI messages will then be 
sent through the MIDI OUT port to the personal computer where Hauptwerk software will translate the MIDI message 
commands into actions on the organ. Table-7 shows the types of messages sent for the individual functions:  

Table 7: MIDI messages relevant to Hauptwerk  
 

Function MIDI command 
Keyboards & 
Pedalboard 

1. Note on/off 
2. Channel number 
3. Key number 

Stops Note on/off 
Pistons Program change 
Volume Program change (Controller-7) 
Expression Program change (Controller-7) 
Crescendo Program change 

Table 8: Default Configuration for Hauptwerk  
 

 CMK Config Software 

Physical Position 
CMK Config 

MIDI Channel 
CMK Config 

Order * 
Solo   5 #1 (Top) * 
Swell 3 #2 
Great 2 #3 
Choir 4 #4 (Bottom) *
Pedal 1 n/a 

Cresc. Shoe 7 any 
Swell Shoe 3 #3 
Choir Shoe 4 #4 * 

 
* If you have fewer keyboards, their MIDI Channel numbers are simply omitted and the Configuration Order changed 
to suit with your top keyboard as #1, but the Crescendo should remain on MIDI Channel-7. This table assumes you are 
using our pedalboard and that it is wired and connected as per Figure-6. Crescendo can wired to any keyboard as long 
as it sends its message on Channel-7. The setup in Hauptwerk can be configured to suit. The pedalboard does not use a 
CMK-2 board so is not configurable by this software. 
 
For more information, or to download a shareware version of Hauptwerk software, please visit:  
 http://www.crumhorn-labs.com  
 
SCPOPTM   
Sound Canvas Pipe Organ Project (SCPOP) is a computer program that emulates organ features like stop changes, 
keyboard coupling, tremolo, assignable memories, temperament changes, and the ability to choose different reverb 
settings. All of the features can be accessed using the computer keyboard’s keys like a true organ console.[5]  
 
SCPOP requires a Roland Sound Canvas MIDI Expander module and is only compatible with Roland hardware 
containing the ‘Sound Canvas’ label[6]. The messages used to control SCPOP can be found in Appendix E. 
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MIDI Hardware Specification[1]  
 
The only MIDI connector approved by the MIDI Manufacturers Association is a 5-pin 180º DIN connector. There are 
other ways of connecting devices to send MIDI messages but it is easier to have compatibility between different MIDI 
devices if there is a standard connector. In connecting a MIDI device to a personal computer, the simplest way is 
through the MIDI ports of a computer (MIDI connectors are uni-directional from the ‘OUT’ connector to the ‘IN’ 
connector). Due to space limitations of computer circuit boards, most computers are not equipped with a MIDI port. 
Thus, adapters must be used that connect the MIDI device to another port. The most common port is the computer’s 
game port that is found on most soundcards. Adapters are also available for the serial port, parallel port, and USB port.  
 
A schematic of the 5-pin DIN connector typical interface is shown below: The basic signal is a negative-going pulse 
on pin-5. 

 

Figure 10: 5-pin DIN connections  
MIDI Hardware NOTES:  
1. Opto-isolator shown is Sharp PC-900. HP 6N138 or other types can be used with changes. 
2. Gates ‘A’ are Integrated Circuit or transistor; Resistors are 5%.  
3. Maximum cable length is fifty feet (15 meters), terminated at each end by a 5-pin 180º DIN male plug (e.g. SWITCHCRAFT  
 05GM5M). 
4. Cable is shielded twisted-pair, with shield connected to pin 2 at both ends. 
5. MIDI In ground is not connected (to avoid Ground Loops). 
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CLASSIC MIDI KEYBOARD 
CMK-2-1 

 

5. HARDWARE CONFIGURATION  
Introduction  
 
The CMK-2 is customizable to suit many organ applications. Up to four CMK-2 keyboards may be stacked level, or 
tilted if the optional mounting brackets are purchased. Each keyboard has 61-keys that serve for programming as well 
as musical purposes. Three useable analog inputs are available (for volume/expression and crescendo adjustment).  
 
Note: While you can set the keyboard functions in this way, pistons must be set up using the Configuration software. 
See 6. Software Configuration. 
 

Power-On Self Test  
 
The CMK-2 has a built-in self-test that executes upon power up.  
 

Analog Input Pins  
 
There are three analog inputs on the CMK-2, each with three-pin terminal blocks. Keyboard Analog devices must be 
connected to the analog input pin ‘2’, a positive voltage (+5V) on pin ‘1’, and ground potential (0V) on pin ‘3’. 
Depending on the position of the analog device, a voltage will be read by the processor that will determine the setting. 
In the case of a volume control, the position of the analog device will determine the loudness level. See Figure 9.  

MIDI Crescendo – for Ahlborn Archive modules  
MIDI messages are sent to add stops progressively to a registration. ‘Analog Input 3’ is used for Crescendo.  

MIDI Volume  
A MIDI controller-7 message is sent to change the loudness level of the stop or sound (typically for Ahlborn Archive 
modules). The MIDI volume analog input must be configured to transmit on one or more MIDI channels as outlined in 
Table 9.  

MIDI Expression  
A MIDI controller-11 message is sent to set the loudness level within the preset volume range (typically for 
Hauptwerk). ‘Analog Input 1’ is used for Expression but can also be used for Volume. Expression messages adjust the 
loudness within a range not exceeding the maximum set by volume. The MIDI Expression analog input must be 
configured to transmit on one or more MIDI channels as outlined in Table 8. In multi-manual CMK-2 setups, the range 
for the Expression control can be set by attaching a Volume control to one of the keyboards and attaching an 
Expression control to another keyboard. If the volume and expression controls are set to produce messages on the same 
MIDI channels, the volume control will set the maximum range while the expression control will change the loudness 
level in the volume range.  
 



MIDI KEYBOARD CMK-2 HARDWARE CONFIGURATION MANUAL v1.5 
 

 

 
22 2009 CLASSIC ORGAN WORKS CMK-2 Manual 1.5.doc 

Programming Keyboard Functions  
The following chart lists the functions manually settable using only the piston pushbuttons and keyboard key-switches. 

Table 9: Programming Functions 
 

Name Steps Function 

1. SOFT REBOOT Simultaneously press the first piston 
from the left (SET) and last piston on 
the right (CANCEL). 

Performs a soft reboot. This will restart the keyboard and reload 
configuration data from the on-board EEPROM. 

2. SET MIDI 
CHANNEL(S) 
ACTIVE 

 

Hold the first piston from the left (SET) 
and momentarily press the first black 
key from the left (C#1). While still 
holding SET, momentarily press one or 
more of the first 16 white keys from the 
left (C1 to D3). Afterwards, release the 
SET piston. 

Sets the output MIDI channels for the keyboard. For example, if 
we configure the keyboard to transmit on channels 1, 3 and 5, 
then all MIDI events originating from that keyboard will produce 
MIDI messages on these three channels.  C1 for Channel-1, E1 
for Channel-3, G1 for Channel-5, etc. 

3. SET MIDI 
CHANNEL(S) 
INACTIVE 

Hold first piston from the left (SET) 
and momentarily press the second black 
key from the left (D#1). Afterwards, 
release the SET piston. 

Clears all output MIDI channels for the keyboard. You cannot 
clear just one but must clear all and start again as above. 

You can change just one by using the configuration software. 

4. SET DEFAULT 
VELOCITY  
(if keyboard is presently 
in the non-velocity 
mode) 

Hold the first piston from the left (SET) 
and momentarily press the third black 
key from the left (F#1). Then 
momentarily press any one of the 36 
white keys and release the SET piston. 

Repeating the above will set the next 
active MIDI channel that has velocity-
sensing turned Off. 

Selects the default velocity for the lowest-numbered active MIDI 
channel with velocity-sensing set Off. Uses the white keys to 
select a velocity level between 0 (bass end: softest) and 127 
(treble end: loudest). Keys pressed in between will produce a 
velocity level between 0 and 127 proportional to the location of 
the key relative to the extremes. The change in velocity level 
between adjacent white keys is approximately 3.  

Note that if multiple keys are pressed, only the last one released 
will be registered by the software. 

5. SET VELOCITY 
SENSING OFF 

Hold the first piston from the left (SET) 
and momentarily press the fourth black 
key from the left (G#1) to turn off 
velocity sensing. Afterwards, release the 
SET piston.  

The MIDI Channel with the lowest 
active number will be set to velocity-
sensing Off and will use the default 
velocity value. 

Velocity sensing produces a different volume level corresponding 
to the speed with which a key is pressed. To conform to 
traditional organ consoles which are not velocity sensitive, the 
CMK-2 permits users to disable velocity-sensing in the keyboard. 

6. SET VELOCITY 
SENSING ON 

Hold first piston from the left (SET) 
and momentarily press the fifth black 
key from the left (A#1) to turn on 
velocity sensing. Afterwards, release the 
SET piston. 

The MIDI Channel with the lowest 
active number that is presently in the 
Velocity-sensing Off mode will be set to 
velocity-sensing On. 

Velocity sensing produces a different volume level corresponding 
to the speed with which a key is pressed. To conform to 
traditional organ consoles which are not velocity sensitive, the 
CMK-2 permits users to disable velocity-sensing in the keyboard. 
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Name Steps Function 

7. SET A MIDI 
CHANNEL TO 
SEND VOLUME 
MESSAGES 
(CONTROLLER-7) 

Hold the first piston from the left (SET) and 
momentarily press the sixth black key from 
the left (C#2) once, twice or three times on 
one of the sixteen white keys (C1 to D3). 
Afterwards, release the SET piston. 

The quantity of presses corresponds to the 
number of the analog input (#1 to #3) while 
the white key defines the MIDI channel (1 to 
16) on which you want the volume message 
to be sent.  

Each MIDI channel must be set separately in 
this manner. 

Sets the volume message on one MIDI channel. Any 
channel can be set but only an active one will transmit 
a message. 

If you hit different white keys before releasing SET, 
only the last one will be recognised and enabled 
according to the quantity of presses you made. More 
than three presses will be treated as three. 

Note that the crescendo input does not require setup 
because it produces messages for the Ahlborn Archive 
modules. 

8. DISABLING 
VOLUME 
MESSAGES 
(CONTROLLER-7) 

Hold the first piston from the left (SET) and 
momentarily press the sixth black key from 
the left (C#2). Afterwards, release the SET 
piston. 

Clears the volume settings for all active MIDI 
channels on the keyboard. You cannot clear just one 
but must clear all and start again as above. You can 
change just one by using the configuration software. 

9. SET A MIDI 
CHANNEL TO 
SEND EXPRESSION 
MESSAGES 
(CONTROLLER-11) 

Hold the first piston from the left (SET) and 
momentarily press the sixth black key from 
the left (D#2) once, twice or three times on 
one of the sixteen white keys (C1 to D3). 
Afterwards, release the SET piston. 

The quantity of presses corresponds to the 
number of the analog input (#1 to #3) while 
the white key defines the MIDI channel (1 to 
16) on which you want the expression 
message to be sent.  

Each MIDI channel must be set separately in 
this manner. 

Sets the expression message on one MIDI channel. 
Any channel can be set but only an active one will 
transmit a message. 

If you hit  different white keys before releasing SET, 
only the last one will be recognised and enabled 
according to the quantity of presses you made. More 
than three presses will be treated as three. 

Note that the crescendo input does not require setup 
because it produces messages for the Ahlborn Archive 
modules. 

10. DISABLING 
EXPRESSION 
MESSAGES 
(CONTROLLER-11) 

Hold the first piston from the left (SET) and 
momentarily press the sixth black key from 
the left (D#2). Afterwards, release the SET 
piston. 

Clears the expression settings for all active MIDI 
channels on the keyboard. You cannot clear just one 
but must clear all and start again as above. You can 
change just one by using the configuration software. 

11. SET 
TRANSPOSE 
VALUE 

Hold the first piston from the left (SET) and 
momentarily press any key EXCEPT the first 
seven black keys. Then, release the SET 
piston. 

The next key pressed will send the note 
number that Middle-C will become. 

For example, if you want to transpose down two semi-
tones to B-flat, press B-flat (A#2). Transposition is not 
cumulative. 

If you need to set it where one of the first seven black 
keys is, you will have to use the General Settings 
window. See 6. Software Configuration. 

 
NOTE : 

All configuration changes made as above will be saved permanently (written to the EEPROM) after SET 
is released. These settings will remain, even if the keyboard power is removed. All but the first can be set 
using the configuration software for Windows or MacIntosh computers. 
The SET piston in a multi-keyboard system must be the one on the keyboard you want to edit. 
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CLASSIC MIDI KEYBOARD 
CMK-2-1 

 
6. SOFTWARE CONFIGURATION  
(PC WindowsTM and MacIntosh Users) 

Introduction  
 
Users with access to a personal computer running WindowsTM 1 or MacIntoshTM 2 operating systems can use the 
‘CMKConfig’ software (contained in the compact disc) to program additional configurations. These configuration files 
describe the features of each keyboard such as output MIDI channel and the function of each piston. The software 
allows users to create configuration files, change existing configuration files, and use existing configuration files.  

Software Installation  
 
The CMK-2 includes a compact disc (CD) with software allowing users to create custom configurations. To use the 
software, the CMK-2 must be connected to a personal computer running the Windows operating system software 
(Windows 98, 2000, XP) or MacIntosh System-X. The CMK-2 must be connected to the computer using MIDI. If 
a MIDI port is not available on your computer, commercial MIDI adapters for the game port, USB port, and parallel 
port may be used. A typical USB-to-MIDI converter is the M-Audio MIDIman 1x1. When the installation CD is 
placed in the optical drive of your computer (CD drive), the software installation wizard should automatically run. If 
however, the software installation wizard does not automatically run, follow the steps below: 
 
For Windows: 

1. Open the ‘Start’ menu and click on ‘Run’. 
2. Click on ‘Browse’ and select the optical drive (CD drive) from 
the ‘Look in:’ drop down menu. 
3. Locate and click on a file named ‘CMK_Setup.exe’. 
4. Follow the instructions in the software installation wizard 
(screen captures are shown below). 

 
For MacIntosh: 

1. The CD icon will appear on the desktop. Double-click on the 
icon to show its contents. 

2. Drag all the files to a new folder on the hard drive. Name it 
CMK. 

3. Double-click on the zipped file among the list and it will open 
up into a list of files. 

4. Double-click on ‘CMKconfig.app’. 
5. Right-click and make an Alias of this program for the dock. 

Figure 11 Installing ‘CMK-2_Setup.exe’ file.  

                                                           
1 Windows is a registered Trademark of the Microsoft Corporation. 
2 MacIntosh is a registered Trademark of Apple Computer Corporation. 
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Figure 12 Select a directory to install the program  

Figure 13 Adding an icon to the start menu  
 

 
 
 

 

 

 

 

Figure 14 Creating an icon on the desktop 

Figure 15 Confirmation window  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 16 Setup progress window  

Figure 17 Confirms successful installation
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Software Startup  
 
After installation, a shortcut (or alias) titled ‘CMKConfig’ will be created in the ‘Classic Organ Works’ folder (Start 
menu→ Programs→ Classic Organ Works→ CMKConfig). To start using the software, double-click your left mouse 
button on this ‘CMKConfig’ shortcut/alias. You should then see a screen as shown below:  
 

 

Figure 18 Config software startup screen.  
 

After a few moments, the main menu selection will appear: 
 

 
 

Figure 19 Config software main menu.  
 
The main menu allows you to select one of two sources for the configuration and presents you with a selection window 
from which you choose a file in the normal manner: 
  

1. Load Current Settings from the CMK: This mode reads from a file in the CMK-2 memory. 
2. Open Previously Saved CMK Configuration: This mode reads from a file stored on your computer. 

 
Both sources allow you to modify settings and eventually save either back to the MCU or to the computer under a new 
filename. In the case of a  multi-keyboard system, all the memories are read in ‘daisy-chained’ sequence as one file 
and saved back to their respective sources. You can load configuration files created with older software versions and 
save them back in the new format. 
 
Note: If the MIDI connection is not present when you attempt to open the file in the CMK-2, the software will keep 
retrying to connect. Even though you then connect it, it still may not run. If so, close the CMKConfig program and 
restart it. 
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Functions of the Menus  
 
The software has a toolbar that contains icons for five main functions. The menus can also be used: 
 

 

Figure 20: Toolbars in CMK-2Config software  

1. File Menu  
• Open a Previously Saved CMK Configuration – Loads a configuration file (with a ‘.CMK’ 

extension) from the computer to the Classic CMKConfig software. The user may then edit the file as 
desired. 
Keyboard shortcut: Ctrl+O Windows Icon:  
 
To begin loading a configuration go to File → Open Previously Save CMK Configuration, or use the 
Keyboard shortcut, or icon shown above. A window prompting the user for a filename should appear: 

 
 The user can then select the filename and click on the ‘Open’ button, or double-click on the name. 

 
• Save CMK Configuration File – Saves a configuration file to be stored on the computer. All 

configuration files have a ‘.CMK’ extension. On the MacIntosh, the default name is ‘data’ and the file 
will save with a ‘CMK’ suffix. 
Keyboard shortcut: Ctrl+S Windows Icon:  

 
To save a configuration file to the PC, go to File → Save Program Data File, or use the Keyboard 
shortcut or icon shown above.  
 
A window prompting the user for a filename should appear. Give the file a name (no need to type 
.cmk) and it need not be ‘p#’. It can have any name you wish. 
 
Tip: A single click on an existing name will put that name into the box. You can then modify it to save 
some typing before you save it. 
 
If the configuration uses the same name as a previous configuration, a warning window will ask the 
user for confirmation in replacing the old file with the newly-revised one. 

 
• Load Current Settings from the CMK – Loads the configuration file from the CMK-2 memory chip. 

There is only the one configuration. 
Keyboard shortcut: Ctrl+L Windows Icon:  

 
To load a configuration from the CMK-2 memory chip, the user must ensure that the CMK-2 is 
connected to power and to a computer using a MIDI cable (see Software Installation for details on 
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connecting MIDI devices to computers). Then go to File → Load Program Data From CMK-2, or use 
the keyboard shortcut or icon as shown above. A window appears attempting to make a connection. 

 

 

Figure 21: Software attempting to connect  
If a connection is not available, a window will appear as a reminder to make connections to the CMK-2: 

 

 

Figure 22: MIDI Interface device choice  
 
If a connection is made, a window will appear to confirm the communication. 
 

 

Figure 23: Software detecting keyboards  
 
After the user has the desired configuration number, pressing ‘OK’ will display a window to confirm 
the selection: 
 

 

Figure 24: Loading configuration.  
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• Write Program Data to CMK – Saves a configuration file to the CMK memory chip. Typical CMK 
units have only the one file in memory.  
 
Note: The configuration file for a multi-keyboard system contains data for all the keyboards. If you 
save the configuration back to such an installation, it will write the appropriate information to them. 
Unchanged keyboard data will simply be resaved to where it came from. See Figure-6. 

Keyboard shortcut: Ctrl+W Windows Icon:   
 
To save a configuration to the CMK-2, go to File → Write Program Data to CMK or, use the keyboard 
shortcut or icon as shown above. The Software attempts to make a connection to the CMK-2. 
 

 

Figure 25: Requesting CMK Configuration  
 
 
A window should appear to confirm that the contents were written. 
 

 

Figure 26: Confirmation Window.  
 

2. Edit Menu  
• Copy and Paste – Two file icons are for Copy and paste functions and are greyed out as not 

applicable. They are not used in this software. 
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3. Options Menu  
• MIDI I/O Setup – This function sets the MIDI input and output ports on your PC. 

Keyboard shortcut: Ctrl+M Windows Icon:   
   

 
 

 

Figure 27: MIDI Input Output Setup windows  
 
A typical MIDI interface is the M-Audio MIDIsport 1x1, which is a 1-In, 1-Out, USB-to-MIDI converter and comes 
with drivers for both Windows and MacIntosh computer systems. 
 

4. Help Menu  
a. View CMK Config Documentation – This function displays the CMK documentation in a web 

browser. It applies only to the Windows version and contains much the same information as this 
document. However, there are differences that may prove useful. 

 
b. About CMKConfig – This window appears briefly. 
 

 

Figure 28: Help Menu  
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Configuring Multiple Keyboards  
 
The software supports multiple-keyboard CMK-2 setups but each keyboard stores its own configuration. 
 
For multiple-keyboard setups, the software screen will show all the connected keyboards rather than a single keyboard. 
The keyboards are read in ‘daisy-chained’ order as one file.  
 
The various MIDI sources are merged in the CMK to prevent conflicts when keys are pressed simultaneously. 
 
In the single keyboard setup, the keyboard is labeled ‘Manual #1’ in the CMKConfig program window. However, for a 
multi-manual setup, the other keyboards are numbered according to their places in the daisy-chain from the top down.  
 
Hence, the keyboard labeled ‘Manual #1’ represents the keyboard connected directly to the MIDI OUT port of the 
personal computer (via an interface unit, and pedalboard, if necessary) and is the topmost one in the stack. This MIDI 
OUT connection from the computer is used only for programming the CMK-2 units and should be omitted once 
configuration is complete as it may cause problems. ‘Manual #2’ would be connected to the MIDI OUT port of 
‘Manual #1’ and so on.  
 
The final keyboard in the chain will have one MIDI OUT port connected back to the MIDI IN port on the personal 
computer (via the interface unit if necessary). The final keyboard also connects to any Ahlborn Archive, General MIDI 
sound modules, Hauptwerk, etc., through its other outputs. 
 
The ‘daisy-chained’ order of the keyboards is not necessarily the same as the MIDI Channel order. See Table-8 for the 
default Hauptwerk configuration. 
 
Using the software for setup of multiple keyboards is the same as for the single-manual, although you must configure 
each one separately. For more details on correct installation, please see Figure 2 in the ‘Introduction’ section.  
 
Note: A configuration for multiple keyboards contains data for all the keyboards. So, if you save an edited 
configuration back to a multiple-keyboard installation, it will write the new configuration to all keyboards as 
appropriate. Hence, if there were no changes to, say, one of them, its configuration will be resaved unchanged. 
 
You can also configure each keyboard manually using the SET piston in combination with keys. See 5. Hardware 
Configuration. However, you can only configure the pistons through software. 
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Edit a Previously-Saved CMK Configuration  
 
CMK-2 configuration files are saved on either kind of computer in the format: filename.CMK. Such a configuration 
file may be edited to the new specifications. The user can then choose to save the new settings back to the computer or 
transfer the file to the CMK-2 memory as a new configuration (over-writing the old one). When a user selects the 
‘Open a Previously Saved CMK Configuration’ option from the main menu, the software prompts for a filename 
through the following window: 
 

 

Figure 29: Configuration File selection window.  
 
If you load a file from the computer, this window appears: 

 
 
 
 
 
 
 
 
   
 

If you load the file from the CMK, you get this window (there is only the one configuration in the CMK memory): 
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1. Keyboard Functions, MIDI Channels 
 
After loading a file (and closing the window), a window should appear like the one shown below:  
 

 
 

 

Figure 30: Program window  
  
If there are multiple keyboards, you will see them all in the window. They will be numbered in the ‘daisy-chained’ 
order (#1 being the top one) that is not necessarily the MIDI-channel order. Click on the one you want to edit. 
 
Note: If you save an edited configuration back to a multiple-keyboard installation, it will write the changed 
information to the keyboard in question and resave unchanged data back to the others. 
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At this point, the user may customize each of the keyboards through drop-down menus.  MacIntosh version screens are 
similar in appearance and function so are not shown here. 
 
The first thing to do is to click on a keyboard and then, if necessary, click on the MIDI-channel tick box to define to 
which MIDI channel that keyboard will be assigned (see above diagram). Then all boxes in the same horizontal row 
will apply to that keyboard. For other keyboards in a multi-keyboard system, first click on the appropriate keyboard. 
 
Under Key Offset, select a number that determines if the keyboard pitch is to be transposed up or down in semi-tones. 
The range is from –36 to +91 and 0 is normal since Middle-C is MIDI note 36 (24hex)). (Middle-C is keyboard key 
number 25, which is actually MIDI key number 24). This function can also be set manually by using pistons and keys. 
See 5. Hardware Configurations and Note On/Off (under Piston Functions). However, some keys are used for other 
purposes. If you must use such a key, the transposition should be performed in this window instead. Transposition can 
be set on/off in the General Settings window (next page). 
 

 
 
The Velocity On/Fixed drop-down menu allows for setting of the velocity-sensitive number 
from 0 to 127 if ticked, but only if MIDI is activated in that horizontal row. It can be set to a 
default value and then un-ticked if desired (unticked is disabled and cannot be adjusted). 
 
 
Tip: If you highlight a box by clicking on it, you can use the mouse scroll feature to navigate the 
contents of the drop-down menu. 
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2. Expression Shoe Functions 
 
Each manual has three Analog Inputs that can be configured for either Expression or 
Volume Control. To select these functions, click on the drop-down menus and set the 
shoe functions as desired.  
 
 

The Analog Inputs are used for either an expression shoe or a volume control. Volume would 
typically be used for an Ahlborn Archive module while Expression would be used for Hauptwerk. 
Volume sets the overall maximum loudness while Expression varies volume level from a minimum 
up to that overall level. Other MIDI sound generators may use either. Consult their manuals for 
details. 

 
It is possible to use an input for Ahlborn Crescendo but this is set in General Settings, not here. See below. 

3. General Settings  
 

 
 

This window shows a list of the various manual (hardware configuration) functions that can be enabled or disabled via 
tick boxes. The various manual keyboard shortcuts are also shown using the pistons (P1 is Piston #1, Left, SET. The 
others are the first seven black keys).  
 
These shortcuts are detailed in 5. Hardware Configuration. 
 
Transposition here is a simple on/off function. The actual range should be set in the MIDI Settings tab window or 
manually. 
 
The Ahlborn Archive Crescendo settings are unique to Ahlborn Archive modules and would typically use Input #3 on 
MIDI Channel #16. If not required, set its analog input to ‘Disabled’. 
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4. Piston Functions 
 
Each piston can be configured for a particular function. To select these functions from a menu, click on any one of the 
twenty piston buttons and navigate through the resulting drop-down menus. A dotted circle will appear in the selected 
piston in Windows versions showing the current selection. On the Mac, shaded pistons indicate that the piston has been 
assigned to something. Moving the cursor over an assigned piston will reveal what the current assignment is. 
 

   

Figure 31: Piston function drop-down menu.  
 
Note that configuring pistons in software does not affect the use of the two end buttons to set keyboard hardware 
parameters as shown in Table-8. However, they should preferably be left unassigned on the bottom keyboard of a 
multi-keyboard stack as their normal organ use is for SET and General Cancel. They can be assigned to something else 
for other keyboards. 

 
 
 
 
 
 
 

 
Three drop-down menus enable the user to select the MIDI device being controlled, specific function of that device 
(that varies with piston function), and the MIDI output channel for the command (in some instances the MIDI channel 
might not be the same as the one for the keyboard itself). Program Change number is normally the piston number  from 
1 to 20. 

 
 
 
 
 
 
 
 
 

The above two screens show typical settings for a General piston for use with Classic control system. The Number 
would then need to be assigned. Not all the function screens are shown, as most are self-explanatory. MacIntosh 
version screens are similar. 
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Table 10: Customizable Functions for Pistons 
 
Ahlborn: 

 Ahlborn Coupler: Allows a keyboard to play stops from another division 
A to Pedal B to Pedal B to A A to B A to Aux B to Aux 

Ahlborn Tremulant 
Swell Tremulant Great Tremulant Choir Tremulant    
Ahlborn Cancel 
General Cancel Swell 

Divisional Cancel 
Great 

Divisional Cancel 
Choir 

Divisional Cancel 
  

Ahlborn General: associates a combination of stops to a memory level.  
These combinations can be from different divisions. 

Memory A 
General #1 

Memory A 
General #2 

Memory A 
General #3 

Memory A 
General #4 

Memory A 
General #5 

Memory A 
General #6 

Memory B 
General #1 

Memory B 
General #2 

Memory B 
General #3 

Memory B 
General #4 

Memory B 
General #5 

Memory B 
General #6 

Memory C 
General #1 

Memory C 
General #2 

Memory C 
General #3 

Memory C 
General #4 

Memory C 
General #5 

Memory C 
General #6 

Memory D 
General #1 

Memory D 
General #2 

Memory D 
General #3 

Memory D 
General #4 

Memory D 
General #5 

Memory D 
General #6 

Memory E 
General #1 

Memory E 
General #2 

Memory E 
General #3 

Memory E 
General #4 

Memory E 
General #5 

Memory E 
General #6 

 
Ahlborn SET: Assigns stops to a piston 
Ahlborn SFZ: Activates all stops 

 
Hauptwerk: 

Hauptwerk/Program Change: Allows users to control Hauptwerk functions or send program change  
commands using the pistons 

Any Program Change number from 1 to 128 
 
SCPOP: 

SCPOP function: Allows user to control SCPOP functions 
Left Up Center Down Right Clear 

Great Flues Swell Flues Great Mixture Great Reeds Swell Reeds Pedal Stops 
Great to Swell Great to Pedal Swell to Great Swell to Pedal Tremolo Swell Tremolo Great 

Panic Rec Thru Reset Cancel  
Free 

Memory # 1 
Free 

Memory # 2 
Free 

Memory # 3 
Free 

Memory # 4 
Free  

Memory # 5 
 

Free 
Memory # 6 

Free 
Memory # 7 

Free 
Memory # 8 

Free 
Memory # 9 

Free  
Memory #10 

 

Fixed 
Memory # 1 

Fixed 
Memory # 2 

Fixed 
Memory # 3 

Fixed 
Memory # 4 

Fixed  
Memory # 5 

Fixed 
Memory # 6 

Fixed 
Memory # 7 

Fixed 
Memory # 8 

Fixed 
Memory # 9 

Fixed 
Memory # 10 

Fixed 
Memory # 11 

Fixed 
Memory # 12 

Go Flues Mute Sw Flues Mute Go Reeds Mute Sw Reeds Mute Unused  
Temper 
Type – 

Temper 
Type + 

Temper 
Key – 

Temper 
Key + 

Reverb  
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BANK SELECT: Gives choice of MSB, LSB, Program Change number and MIDI Channel 1-16. 
 
CM-100 TREMULANT: Gives range of 0-127 for Tremulant Depth only, and MIDI Channel 1-16. 
 
CM-100 CANCEL: No Choice, the piston will simply turn off all CM-100 stops. 
 
NOTE ON/OFF: Gives choice of 0-127 where Middle-C is 24, on MIDI Channel 1-16. The individual note turns On 
when pressed and Off when released. This might be used, perhaps, to operate a percussion sound on MIDI Channel-10. 
See Appendix-F for General MIDI Sounds. 
 
ALL NOTES OFF: Effectively a Divisional Cancel piston to overcome stuck notes on one MIDI Channel (1-16). 
 
CLASSIC: 

CLASSIC Function: Allows user to directly control Classic Control Systems 
CASE NUM CASE NUM CASE NUM 

Divisionals 
00-0E 

0-F Generals, 
 First Set.  

0F 

0-F Combo Action 
Memory, Direct 

Access 10 

0-F 

Generals, Second 
Set. 11 

0-F Cancels 
12 

Div. 0-E 
Gen. F 

Sforzando 
13 

0-7 

Ventils 
14 

0-7 Control, Up/Down 
MEM, Reg. Seq., 

Transp., SETUP 15 

0-3 Special Functions 
Lighted Rev. First Set 

16 

0-7 

Lighted Rev. 
Second Set 

17 

0-F Piston Couplers 
18 

1-7 
(not 0) 

Coupler Rev. 
First Set 

19 

0-F 

Up/Down 
1A 

0 Up 
1 Down 

Reg. Sequencer 
1B 

0 Next 
1 Last 

Recall 
1C 

0 

Coupler Rev. 
Second Set 

1D 

0-F MIDI Memory 
Direct Access 

1E 

0 Up 
1 Down 

Transpose 
1F 

0 Up 
1 Down 
2 Cancel 

Spare 
Unused 

20 

0 MIDI Stop 
Direct Access 

21 

0-F Crescendo 
Memory 

22 

0 Alterable 
1-3 Select 

MIDI Sustain 
23 

0 Settable Tab 
Reversibles 

24 

0-F Spare 
Unused 

25 

0 

SET/ALT 
26 

0 Memory Lock 
27 

0 Unlock 
1 Lock 

Other Tabs Off 
Reversibles 

28 

0 

Player 
29 

0 Play 
1 Pause/File 

2 Record 

MIDI Sequencer 
Program Number 

2A 

0-F MIDI Sequencer 
Program Number 

2B 

0-F 

MIDI Expander 
Program Number 

2C 

0-F MIDI Expander 
Program Number 

2D 

0-F Misc. Up/Down 
Special 

2E 

0 

Coupler Rev. 
Third Set 

2F 

0-F Numeric Hex Display 
30 

0 Lighted Rev. 
Third Set, Special 

31 

0 





MIDI KEYBOARD CMK-2 REFERENCES MANUAL v1.5 
 

  

CMK-2 Manual 1.5.doc 2009 CLASSIC ORGAN WORKS 41 

MIDI CONTROL UNIT 
CMK-2 

 
7. REFERENCES  

 
 
[1] “What is MIDI” [Online Document], 1995, [cited 2002 December 12], Available HTTP: 

http://www.midi.org/about-midi/abtmidi.htm 
 
[2] “Archive Technical Specifications” [Online Document], 2002, [cited 2002 December 17], Available HTTP: 

http://www.ahlborn-galanti.com/archive/techspec.html 
 
[3] “Archive Stops” [Online Document], 2002, [cited 2002 December 17], Available HTTP:  

http://www.ahlborn-galanti.com/archive/stops.html 
 

[4] “Hauptwerk: a Virtual Pipe Organ Project” [Online Document], 2003, [cited 2003 January 6], Available 
HTTP: http://www.hauptwerk.co.uk 

 
[5]  “What is SCPOP?” [Online Document], 2002 December, [cited 2002 December 17], Available HTTP: 

http://www.chsinet.via.t-online.de/Project_all.htm 
 
[6] Filippo Tigli, “Frequently Asked Questions” [Online Document], 2002 October, [cited 2003 January 7], 

Available HTTP: http://www.chsinet.via.t-online.de/faq.htm 
 
[7] R. Sung, System Exclusive Message layouts, Classic Organ Works, Markham, Canada: 2002  

 
[8] H. Wemekamp, Classic MIDI Keyboard Interface System Software, Classic Organ Works, Markham, Canada: 

2002 
 
 
 





MIDI KEYBOARD CMK-2 APPENDIX-A SYSEX MESSAGES
 

  

CMK-2 Manual 1.5.doc 2009 CLASSIC ORGAN WORKS 43 

CLASSIC MIDI KEYBOARD 
CMK-2 

8. APPENDIX A:  
 

SYSTEM EXCLUSIVE MESSAGES  
 
Messages common to all products [7]  
 
General Information Identity Request  
F0 7E dd 06 01 F7  

Request the identity and special characteristics of a device. dd selects a particular device in the MIDI chain.  
dd = 7Fh selects any and all devices at once.  
 
 

General Information Identity Reply 
F0 7E dd 06 02 00 20 1C pp pp mm mm ss ss tt tt F7  

dd: identifies the device which is responding.  
pp pp = 04 03 for MKSC v3 
mm mm: gives the organ model number  
ss ss: identifies the major and minor software revision level, as it affects data format compatibility.  
tt tt: identifies the major and minor software revision level, as it affects program capabilities. 
In the case of the MKSC v3, after the tt tt, also pass two bytes indicated the current DIPSWITCH 
setting  
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CMK-2 – Special layouts[7]  
 
Config Memory  
The config memory contains a number of 256-byte blocks. Each contains CMK-2 configuration information. 
The message formats are:  
F0 00 20 1C dd 04 01 03 aa aa aa ss ss F7  

Request Config Memory data. This message should be sent by an external sequencer or by the CMK-2 config 
application.  

dd: identifies the device which is responding.  
aa aa aa: starting offset (21-bit address) of the config block (packed 7 bits).  
ss ss: number of bytes of original data to be retrieved (packed 14 bits) 
 

F0 00 20 1C dd 04 01 04 bb bb ss <data, 8-for-7 format> F7  
Transfer Config Memory data. This message should be sent from the CMK-2 in response to a request message.  

dd:  identifies the device which is responding.  
bb bb:  block-count within the sequence of saved data blocks' memory data, low-order 7 bits first. The  

first message in a restore sequence must have a block-count of 00 00.  
 ss: number of bytes of original data transferred in this block.  

data:  8-for-7 coded bytes of data.  
 

F0 00 20 1C dd 04 01 08 bb bb aa aa aa ss <data, 8-for-7 format> F7  
Update Config Memory data. The message with subcommand 08 will be generated by the external CMK-2 
config application. 
 
 dd: identifies the device which is responding.  
 bb bb: block-count within the sequence of saved data blocks' memory data, low-order 7 bits first. The 
  first message in a restore sequence must have a block-count of 00 00.  
 aa aa aa: starting offset (21-bit address) of the config block (packed 7 bits).  
 ss: number of bytes of original data transferred in this block.  
 data: 8-for-7 coded bytes of data.  
 

F0 00 20 1C dd 04 01 20 F7  
Soft reboot CMK-2. The message with cause the CMK-2 to resume operation and reload the PIC's EEPROM 
with the contents of the FLASH ROM indicated by the DIPSWITCH.  
  
 dd: identifies the device which is responding.  
 

F0 00 20 1c dd 04 02 ii F7 
Provides an identification number for each keyboard to identify the number of keyboards and configure each 
one separately. The first device is set to 0 and increments this number before passing the message to the next 
device. 
 
 dd: not used in this command. 
 ii: device identification.  
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CLASSIC MIDI KEYBOARD 
CMK-2 

 
9. APPENDIX B:  

 
AHLBORN MESSAGES  

 
Table 11: Note On/Off MIDI functions[8]  

Slot Pins: Data sent: 
Off ----> On 

Data sent: 
On ----> Off Div. Description:  Note: 

     Key On/Off Data   
1 1-61 90 kk 40 90 kk 00 Sw Ahlborn - Note On / Off  1 
2 1-61 91 kk 40 91 kk 00 Gt Ahlborn - Note On / Off  2 
3 1-61 92 kk 40 92 kk 00 Ch Ahlborn - Note On / Off  3 
4 1-32 93 kk 40 93 kk 00 Pd Ahlborn - Note On / Off  4 

 
 
NOTES: 
 
1) "Swell Channel" defaults to 1 (0h) - usually the Ahlborn "A" division for key On/Off messages. kk = Note 

number 0-127 (00h to 7Fh) where 60 (3Ch) = middle "C". Normal (untransposed) output from key inputs 1-61 
= 36-96 (24h - 60h). Transposer may shift this down or up in the range of -24 to +31. 

2)  "Great Channel" defaults to 2 (1h) - usually the Ahlborn "B" division for key On/Off messages. 
3) "Choir Channel" defaults to 3 (2h) - usually the Ahlborn "AUX" division for key On/Off messages.  
4) "Pedal Channel" defaults to 4 (3h) - usually the Ahlborn "Pedal" division for key On/Off messages. Normal 

(untransposed) output from key inputs 1-32 = 36-67 (24h - 43h). Transposer may shift this down or up in the 
range of -24 to +31. 

5) Ahlborn modules respond only in the range - kk = 30-99 (1Eh to 63h) for A and B divisions and kk = 30-70  
  (1Eh to 46h) for the Pedal division.  
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Table 12: Stop & Coupler messages, Romantic[8]  
 

Group No. Data sent 
Off ----> On 

Data sent 
On ----> Off Div. Description Note 

  Controller 73 Controller 74  Ahlborn ROMANTIC stops  
0 0 Bn 49 00 Bn 4A 00 Pd Contre Gamba  16' 1 
 1 Bn 49 01 Bn 4A 01 Pd Ophicleide  16'  
 2 Bn 49 02 Bn 4A 02 Pd Contre Violone 32'  
 3 Bn 49 03 Bn 4A 03 Pd Contre Bassoon  32'  
 4 Bn 49 04 Bn 4A 04 Pd A/P coupler   
 5 Bn 49 05 Bn 4A 05 Pd B to Pd coupler   

 6 Bn 49 06 Bn 4A 06 A Cornopean 16'  
 7 Bn 49 07 Bn 4A 07 A Cornet des Bombardes IV  
 8 Bn 49 08 Bn 4A 08 A Tuba Mirabilis 8'  
 9 Bn 49 09 Bn 4A 09 A Clarion 4'  
 A Bn 49 0A Bn 4A 0A A Orchestral Oboe 8'  
 B Bn 49 0B Bn 4A 0B A Clarinet 8'  
 C Bn 49 0C Bn 4A 0C A French Horn 8'  
 D Bn 49 0D Bn 4A 0D A Cor Anglais 8'  
 E Bn 49 0E Bn 4A 0E A Cello 8'  
 F Bn 49 0F Bn 4A 0F A Cello Celeste 8'  
 10 Bn 49 10 Bn 4A 10 A B to A coupler   
 11 Bn 49 11 Bn 4A 11 B Quint Flute 2 2/3'  
 12 Bn 49 12 Bn 4A 12 B Piccolo 2'  
 13 Bn 49 13 Bn 4A 13 B Vox Humana 8'  
 14 Bn 49 14 Bn 4A 14 B Open Diapason 8'  
 15 Bn 49 15 Bn 4A 15 B Flauto Mirabilis 8'  
 16 Bn 49 16 Bn 4A 16 B Concert Flute 4'  
 17 Bn 49 17 Bn 4A 17  A to B coupler    
 18 Bn 49 18 Bn 4A 18  A to Aux coupler   
 19 Bn 49 19 Bn 4A 19  B to Aux coupler   

 
NOTES: 
1) n = Channel number used by Ahlborn stop On/Off messages; defaults to 16 (Fh). 
2) Controls "A" or "B" division Tremulant on corresponding channel number used by Ahlborn divisions. 
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Table 13: Stop & Coupler messages, Classic[8]  
 

Group No. Data sent: 
Off ----> On 

Data sent: 
On ----> Off Div. Description Note 

  Controller 73 Controller 74  Ahlborn CLASSIC stops  

3 1A Bn 49 1A Bn 4A 1A Pd Contre Gambe 16' 1 
 1B Bn 49 1B Bn 4A 1B Pd Bombarde 16'  
 1C Bn 49 1C Bn 4A 1C Pd Contre Basse 32'  
 1D Bn 49 1D Bn 4A 1D Pd Contre Bombarde 32'  
 1E Bn 49 1E Bn 4A 1E A Corno di Bassetto 8'  
 1F Bn 49 1F Bn 4A 1F A Plein Jeu IV-V  
 20 Bn 49 20 Bn 4A 20 A Clarion 4'  
 21 Bn 49 21 Bn 4A 21 A Festival Trumpet  8'  
 22 Bn 49 22 Bn 4A 22 A Gemshorn Celeste  8'  
 23 Bn 49 23 Bn 4A 23 A Koppelflote  4'  
 24 Bn 49 24 Bn 4A 24 A Bombarde  16'  
 25 Bn 49 25 Bn 4A 25 A Harmonic Trumpet  8'  
 26 Bn 49 26 Bn 4A 26 A Gemshorn  8'  
 27 Bn 49 27 Bn 4A 27 A Flute a Cheminee 8'  
 28 Bn 49 28 Bn 4A 28 B Flute Octaviante  4'  
 29 Bn 49 29 Bn 4A 29 B Octave  2'  
 2A Bn 49 2A Bn 4A 2A B Cymbale  III  
 2B Bn 49 2B Bn 4A 2B B Principal  8'  
 2C Bn 49 2C Bn 4A 2C B Holzgedackt  8'  
 2D Bn 49 2D Bn 4A 2D B Flute Harmonique  8'  

 
NOTES: 
1) n = Channel number used by Ahlborn stop On/Off messages; defaults to 16 (Fh). 
2) Controls "A" or "B" division Tremulant on corresponding channel number used by Ahlborn divisions. 
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Table 14: Stop & Coupler messages, 202[8]  
 

Group No. Data sent: 
Off ----> On 

Data sent: 
On ----> Off Div. Description  Note 

  Controller 73 Controller 74  Ahlborn 202 stops:   

 2E Bn 49 2E Bn 4A 2E Pd Soubasse 32' 1 
 2F Bn 49 2F Bn 4A 2F Pd Violone 16'  
 30 Bn 49 30 Bn 4A 30 Pd Contrebombarde 32'  
 31 Bn 49 31 Bn 4A 31 Pd Bombarde 16'  
 32 Bn 49 32 Bn 4A 32 A Contregambe 16'  

 33 Bn 49 33 Bn 4A 33 A Diapason 8'  
 34 Bn 49 34 Bn 4A 34 A Quintadena 8'  
 35 Bn 49 35 Bn 4A 35 A Terz 1 3/5'  
 36 Bn 49 36 Bn 4A 36 A Septime 1 1/7'  
 37 Bn 49 37 Bn 4A 37 A Scharff III  
 38 Bn 49 38 Bn 4A 38 A Bombarde 16'  
 39 Bn 49 39 Bn 4A 39 A Trompette 8'  
 3A Bn 49 3A Bn 4A 3A A Tuba Mirabilis 8'  
 3B Bn 49 3B Bn 4A 3B A Chimes   
 3C Bn 49 3C Bn 4A 3C B Bourdon 8'  
 3D Bn 49 3D Bn 4A 3D B Flute Harmonique 8'  
 3E Bn 49 3E Bn 4A 3E B Flute Octaviante 4'  
 3F Bn 49 3F Bn 4A 3F B Larigot 1 1/3'  
 40 Bn 49 40 Bn 4A 40 B Corno di Bassetto  8'  
 41 Bn 49 41 Bn 4A 41 B Clarion  4'  

 
NOTES: 
1) n = Channel number used by Ahlborn stop On/Off messages; defaults to 16 (Fh). 
2) Controls "A" or "B" division Tremulant on corresponding channel number used by Ahlborn divisions. 
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Table 15: Stop & Coupler messages, 201[8]  
 

Group No. Data sent: 
Off ----> On 

Data sent: 
On ----> Off Div. Description  Note 

  Controller 73 Controller 74  Ahlborn 201 stops:   

 42 Bn 49 42 Bn 4A 42 Pd Subbass 16' 1 
 43 Bn 49 43 Bn 4A 43 Pd Octave 8'  
 44 Bn 49 44 Bn 4A 44 Pd Bourdon 8'  
 45 Bn 49 45 Bn 4A 45 Pd Posaune 16'  
 46 Bn 49 46 Bn 4A 46 A Bourdon 16'  
 47 Bn 49 47 Bn 4A 47 A Principal 8'  
 48 Bn 49 48 Bn 4A 48 A Flute a cheminee 8'  
 49 Bn 49 49 Bn 4A 49 A Unda Maris 8'  
 4A Bn 49 4A Bn 4A 4A A Octave 4'  
 4B Bn 49 4B Bn 4A 4B A Spitzflote  4'  
 4C Bn 49 4C Bn 4A 4C A Nasard 2 2/3'  
 4D Bn 49 4D Bn 4A 4D A Superoctave 2'  
 4E Bn 49 4E Bn 4A 4E A Mixture  IV  
 4F Bn 49 4F Bn 4A 4F A Trompete 8'  
 50 Bn 49 50 Bn 4A 50 B Gedackt 8'  
 51 Bn 49 51 Bn 4A 51 B Gamba 8'  
 52 Bn 49 52 Bn 4A 52 B Nachthorn 4'  
 53 Bn 49 53 Bn 4A 53 B Cymbale/Scharff III  
 54 Bn 49 54 Bn 4A 54 B Cornet III  
 55 Bn 49 55 Bn 4A 55 B Oboe 8'  
 56 Bn 49 7F Bn 4A 7F  All stops On / Off   
     Ahlborn Tremulants:   
 57 Bn 5C 7F Bn 5C 00  Swell Tremulant  2 
 58 Bn 5C 7F Bn 5C 00  Great Tremulant  2 
 59 Bn 5C 7F Bn 5C 00  Choir Tremulant  2 
        

 
NOTES: 
1) n = Channel number used by Ahlborn stop On/Off messages; defaults to 16 (Fh). 
2) Controls "A" or "B" division Tremulant on corresponding channel number used by Ahlborn divisions. 
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Table 16: Piston & Crescendo messages, all units[8]  
 

Group No. Data sent: 
Off ----> On 

Data sent: 
On ----> Off 

 Description Note 

 A0 CF 20   Ahlborn - General Cancel 1 
 81 CF 01   Ahlborn - Mem. A Gen. #1 2 
 82 CF 02   Ahlborn - Mem. A Gen. #2  
 83 CF 03   Ahlborn - Mem. A Gen. #3  
 84 CF 04   Ahlborn - Mem. A Gen. #4  
 85 CF 05   Ahlborn - Mem. A Gen. #5  
 86 CF 06   Ahlborn - Mem. A Gen. #6  
 87 CF 07   Ahlborn - Mem. B Gen. #1  
  …….   etc.  
 9E CF 1E   Ahlborn - Mem. E Gen. #6  
       
 E4 CF 64   Cancel Crescendo  
 E5 CF 65 CF 64  Crescendo Stage #1 / Off 3 
 E6 CF 66 CF 65  Crescendo Stage #2 / 1  
 E7 CF 67 CF 66  Crescendo Stage #3 / 2  
  …….   etc.  
 EF CF 6F CF 6E  Crescendo Stage #11/10  
 F7 CF 77 CF 6F  Crescendo Stage #12/11  
 F8 CF 78 CF 77  Crescendo Stage #13/12  
  …….   etc.  
 FF CF 7F CF 7E  Crescendo Stage #20/19  

 

 
NOTES: 
1)  Prog#1 (00h) on the Control Channel will actually act as a "Recall Hand Registration", but will correspond to a General 

Cancel if hand registration is not used. 
2) Ahlborn Archive Modules have 6 Programmable Presets on 5 Memory levels, accessed by sending Prog#1-30 (01h - 1Eh). 
3) These functions are presumed to be connected to a "shade roller" Crescendo switch, which provides sequential switch 

closures and releases. These messages can also be generated by an analog input. 
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Table 17: Additional Piston input commands[8]  
 

Group No. Data sent: 
Off ----> On 

Data sent: 
On ----> Off  Description  Note 

 5A Cn 40   Ahlborn – Division Cancel  1 

 5E BF 47 46 BF 47 06  SET piston  2 

 5F BF 47 42 BF 47 02  SFZ control  3 

 
NOTES: 
1) Prog. Change 51-85 (32h - 54h) on a Division Channel (1-4) will actually act as a Divisional Cancel. 
2) Works with General Pistons to allow setting them via remote (MIDI) control, i.e., press & hold SET; press and release a 

General, then release SET; to store a new registration. 
3) Should allow for a lamp output for this. Also, possible another input function which would act as a "reversible"; i.e., push-

ON, push-OFF.: 
4) n = Channel number used by Ahlborn stop On/Off messages; defaults to 16 (Fh). 
 
 
 
 
Table 18: Analog input function commands[8]  
 

Input  Data sent Function Div. Description Note 

1  CF ss Crescendo  Crescendo 1 
       

2  B0 07 aa  Sw Ahlborn – Division Volume 2 
3  B1 07 aa  Gt Ahlborn – Division Volume 2 
4  B2 07 aa  Ch Ahlborn – Division Volume 2 
5  B3 07 aa  Pd Ahlborn – Division Volume 2 
       

6  Bn 65 00 64 
01 06 xx 26 yy Tuning  Tuning and/or Temperature 

Sensor 
3 

 
 
NOTES: 
1) "ss" is the Crescendo stage, where Off=64h, Stage#1=65h, #2=66h, etc., #11=6Fh, #12=77h, #13=78h, etc., #20=7Fh. 
2)  Ahlborn modules use Controller #7 for expression. Outputs on Ahlborn channels (1-4) must be configurable, connecting to 

analog inputs 2-5. aa = volume value from an analog input, where 0<aa<127. 
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10. APPENDIX C:  

 
CIRCUIT BOARD SCHEMATICS  

 
Figure 32: CMK-2A-SS Circuit board Silk Screen  
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Figure 33: CMK-2A Circuit Board Schematic  
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Figure 34: CMK-2 Piston Rail Screen  
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Figure 35: CMK-2 Piston Rail Schematic  
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11. APPENDIX D:  

 
MECHANICAL DRAWINGS  
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Figure 36: CMK-2 Piston Rail Front Panel 
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12. APPENDIX E:  

 

MIDI and SCPOP RESOURCES  
 

• For information on MIDI Protocol Specifications, General MIDI, 
Sound Set Groups or Program Numbers please go to www.midi.org 

 
• For information on SCPOP Messages, please go to www.scpop.de 
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13. APPENDIX F:  

 

GM-MIDI SOUNDS  

MIDI Sound Sets  
 
General MIDI [2]  
 
The MIDI Manufacturers Association (MMA) developed General MIDI (GM) to provide a standard relationship 
between commands and sounds generated by synthesizers. A serious problem developed as the number of MIDI device 
manufacturers grew. Every manufacturer associated a different command to a different sound. Users were confused 
when they used a command to play a piano sound but ended up with a different sound. To alleviate this confusion, the 
MIDI Manufacturers Association dictated that commands termed ‘Patch numbers’ would be the standard reference to a 
sound. A ‘Patch Map’ shows Patch numbers and their respective sounds. In addition, since MIDI transmits using MIDI 
channels, every MIDI sequence begins by assigning a MIDI channel for each sound that is transmitted. This 
assignment is termed ‘Program Change’. 
 
In addition to standardizing the mapping of patch numbers to their respective sounds, the General MIDI protocol 
defines a set of capabilities for General MIDI instruments. Included are a General MIDI Sound Set (patch map), a 
General MIDI Percussion map (maps percussion sounds to note numbers), and a set of General MIDI performance 
capabilities (number of voices, MIDI messages recognized, etc.). 
 
MIDI channels 1-9 and 11-16 are used for chromatic instrument sounds while MIDI channel 10 is used for ‘key-based’ 
percussion sounds. Furthermore, the 128 program numbers are grouped into related sounds sets. For example, program 
numbers 1-8 are for piano sounds, 25-32 are guitar sounds, etc. (a chart is shown on the next page). A note number 
indicates the pitches of the sounds. Note numbers on the ‘key-based’ percussion sounds of MIDI Channel-10 represent 
different percussion instruments. It should be noted that although sounds may have the same label, they might not 
necessarily produce the same sound from different manufacturers’ equipment. The sound output depends on the way 
the sound was made, which is not standard (an ‘Acoustic Grand Piano’ will sound different depending on the way the 
sound was made). Only the patch numbers and their labels are standardized.  
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Table 19: Sound Set Groups  
 

Set Sound 
1-8 Piano 
9-16 Chromatic Percussion 

17-24 Organ 
25-32 Guitar 
33-40 Bass 
41-48 Strings 
49-56 Ensemble 
57-64 Brass 
65-72 Reed 
73-80 Pipe 
81-88 Synthesizer Lead 
89-96 Synthesizer Pad 

97-104 Synthesizer Effects 
105-112 Ethnic 
113-120 Percussive 
121-128 Sound Effects 

 



MIDI KEYBOARD CMK-2 APPENDIX-F GM-MIDI SOUNDS
 

  

CMK-2 Manual 1.5.doc 2009 CLASSIC ORGAN WORKS 63 

Table 20: General MIDI Program Numbers  
 
(Patches) for MIDI Channels 1-9 and 11-16  

 
Patch 
No. 

Name Patch 
No. 

Name Patch 
No. 

Name Patch 
No. 

Name 

1 Acoustic Grand Piano 33 Acoustic Bass 65 Soprano Sax 97 FX 1 (train) 
2 Bright Acoustic Piano 34 Electric Bass (finger) 66 Alto Sax 98 FX 2 (soundtrack) 
3 Electric Grand Piano 35 Electric Bass (pick) 67 Tenor Sax 99 FX 3 (crystal) 
4 Honky-tonk Piano 36 Fretless Bass 68 Baritone Sax 100 FX 4 (atmosphere) 
5 Electric Piano 1 37 Slap Bass 1 69 Oboe 101 FX 5 (brightness) 
6 Electric Piano 2 38 Slap Bass 2 70 English Horn 102 FX 6 (goblins) 
7 Harpsichord 39 Synth Bass 1 71 Bassoon 103 FX 7 (echoes) 
8 Clavinet 40 Synth Bass 2 72 Clarinet 104 FX 8 (sci-fi) 
9 Celesta 41 Violin 73 Piccolo 105 Sitar 

10 Glockenspiel 42 Viola 74 Flute 106 Banjo 
11 Music Box 43 Cello 75 Recorder 107 Shamisen 
12 Vibraphone 44 Contrabass 76 Pan Flute 108 Koto 
13 Marimba 45 Tremolo Strings 77 Blown Bottle 109 Kalimba 
14 Xylophone 46 Pizzicato Strings 78 Shakuhachi 110 Bagpipe 
15 Tubular Bells 47 Orchestral Harp 79 Whistle 111 Fiddle 
16 Dulcimer 48 Timpani 80 Ocarina 112 Shanai 
17 Drawbar Organ 49 String Ensemble 1 81 Lead 1 (square) 113 Tinkle Bell 
18 Percussive Organ 50 String Ensemble 2 82 Lead 2 (sawtooth) 114 Agogo 
19 Rock Organ 51 SynthStrings 1 83 Lead 3 (calliope) 115 Steel Drums 
20 Church Organ 52 SynthStrings 2 84 Lead 4 (chiff) 116 Woodblock 
21 Reed Organ 53 Choir Aahs 85 Lead 5 (charang) 117 Tailo Drum 
22 Accordion 54 Voice Oohs 86 Lead 6 (voice) 118 Melodic Drum 
23 Harmonica 55 Synth Voice 87 Lead 7 (fifths) 119 Synth Drum 
24 Tango Accordion 56 Orchestra Hit 88 Lead 8 (bass+lead) 120 Reverse Cymbal 
25 Acoustic Guitar (nylon) 57 Trumpet 89 Pad 1 (new age) 121 Guitar Fret Noise 
26 Acoustic Guitar (steel) 58 Trombone 90 Pad 2 (warm) 122 Breath Noise 
27 Electric Guitar (jazz) 59 Tuba 91 Pad 3 (polysynth) 123 Seashore 
28 Electric Guitar (clean) 60 Muted Trumpet 92 Pad 4 (choir) 124 Bird Tweet 
29 Electric Guitar (muted) 61 French Horn 93 Pad 5 (bowed) 125 Telephone Ring 
30 Overdriven Guitar 62 Brass Section 94 Pad 6 (metallic) 126 Helicopter 
31 Distortion Guitar 63 Synth Brass 1 95 Pad 7 (halo) 127 Applause 
32 Guitar Harmonics 64 Synth Brass 2 96 Pad 8 (sweep) 128 Gunshot 

        
 
Shaded areas indicate groups with similar sounds. 
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Table 21: General MIDI Percussion Key Map  
 
MIDI Channel 10 only 

 
MIDI Key Note # Key Drum Sound MIDI Key Note # Key Drum Sound 

35 0 B0 * Acoustic Bass Drum 59 24 B2 Ride Cymbal 2 
36 1 C1 Bass Drum 1 60 25 C3 Hi Bongo 
37 2 C#1 Side Stick 61 26 C#3 Low Bongo 
38 3 D1 Acoustic Snare 62 27 D3 Mute Hi Conga 
39 4 D#1 Hand Clap 63 28 D#3 Open Hi Conga 
40 5 E1 Electric Snare 64 29 E3 Low Conga 
41 6 F1 Low Floor Tom 65 30 F3 High Timbale 
42 7 F#1 Closed Hi-Hat 66 31 F#3 Low Timbale 
43 8 G1 High Floor Tom 67 32 G3 High Agogo 
44 9 G#1 Pedal Hi-Hat 68 33 G#3 Low Agogo 
45 10 A1 Low Tom 69 34 A3 Cabasa 
46 11 A#1 Open Hi-Hat 70 35 A#3 Maracas 
47 12 B1 Low-Mid Tom 71 36 B3 Short Whistle 
48 13 C2 Hi-Mid Tom 72 37 C4 Long Whistle 
49 14 C#2 Crash Cymbal 1 73 38 C#4 Short Guiro 
50 15 D2 High Tom 74 39 D4 Long Guiro 
51 16 D#2 Ride Cymbal 1 75 40 D#4 Claves 
52 17 E2 Chinese Cymbal 76 41 E4 Hi Wood Block 
53 18 F2 Ride Bell 77 42 F4 Low Wood Block 
54 19 F#2 Tambourine 78 43 F#4 Mute Cuica 
55 20 G2 Splash Cymbal 79 44 G4 Open Cuica 
56 21 G#2 Cowbell 80 45 G#4 Mute Triangle 
57 22 A2 Crash Cymbal 2 81 46 A4 Open Triangle 
58 23 A#2 Vibraslap     

   
* To access MIDI Key #35 (which is below the bottom of the keyboard), transpose down. 
Note: Some expanders may have additional sounds above and below these numbers. 
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14. APPENDIX G:  

 

ASSEMBLY PICTURES  

Mating the Brackets  
 
Your manuals have come to you pre-assembled. These pictures show you how the brackets connect in case you should 
wish to alter the setup or do maintenance on the manuals themselves. 
 
 

 

Figure 37: Small Mounting Bracket for Top Manual  
 

Figure 38: Large Bracket for other Manuals 

 

Figure 39: Mating the Small and Large Brackets  
 

Figure 40: Connecting Two Brackets  
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Figure 41: Brackets mated and closed  Figure 42: A Four-Manual Stack Open 
 

 

Figure 43: A Four-Manual Stack Closed  
 

 

Figure 44: A Completed Four-Manual Stack 
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15. DISCLAIMER  

 
 

Information contained in this user manual is proprietary and is provided solely for 
the use of customer information and service. The information contained herein 
shall not be duplicated, used or disclosed for design, procurement, manufacturing, 
or any other purpose, in whole or in part, without the written consent of 
ARTISAN CLASSIC ORGAN INC. Information contained in this manual does 
not constitute any legal contract. 
 
 
Although thoroughly edited for correctness, neither Classic Organ Works nor any 
of their employees makes any warranty, express or implied, or assumes any legal 
responsibility for the accuracy, completeness, or usefulness of any information. 
Information is subject to change without notice. The user should visit 
http://www.organworks.com for updates. We appreciate any comments provided 
by users of this manual. Please contact midisupport@organworks.com. For sales 
information, please contact midisales@organworks.com. 
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16. TROUBLESHOOTING  

 
Some typical frequently-asked questions (from the Organ Works website): 
 
CMK config cannot detect my keyboards. I can play every keyboard. However the CMK config software 
cannot detect the keyboard (Retrying... window appears, and nothing happens after that).  
 

CMK config needs both the MIDI IN and OUT connected to the computer. It sounds as if you only have the MIDI IN 
connected. After everything is configured, you should remove the MIDI OUT. You also might not have the necessary 
drivers for your MIDI interface unit. 

 
Will my MIDI interface work with Vista?  
 

Here is a great page on Audio/MIDI interface compatibility with Vista done by Cakewalk (Twelve Tone Systems) 
 
http://www.cakewalk.com/Vista/default.asp 
 
Note that not all interfaces work with a full, 64-bit version of Vista. Many only work with 32-bit so far.  

 
What are the dimensions of a CMK-2 Keyboard stack?  
 

Single: (w x h x d):  35.5" (90.2 cm) x 10" (25.4 cm) x 2.6" (7.1 cm) 
2-Stack: (w x h x d):  35.5" (90.2 cm) x 14.5" (36.9 cm) x 5.5" (14 cm) 
3-Stack: (w x h x d):  35.5" (90.2 cm) x 19" (48.3 cm) x 8.2" (20.9 cm)  
4-Stack: (w x h x d):  35.5" (90.2 cm) x 23.5" (55.7 cm) x 11.5" (29.3 cm)  
 
Note that the short bracket overhangs the back by 1.2", and long ones by 5.5". Keyboards are staggered by 4.5" and are 
2.5" high at the back of the visible keys. The CMK-2 board extends 1" out of the back of a keyboard (but within the 
bracket overhang). Cables need extra depth, say two inches. 

 
I get “re-trying” error message when I start CMK Config. 

 
Check to see if you have both the MIDI IN and OUT cables connected between your MIDI interface and your CMK2 
keyboards. In addition, check to make sure each cable is connected to the correct input and output. You may need to close 
the window and reload the configuration file. You should disconnect the MIDI OUT from your computer after you have 
saved the configuration in the keyboard memory. 

 
I have notes playing or “stuck on” on the screen after I have released the key. 
  

Check to see if you have the MIDI OUT cable connected between your MIDI interface and your CMK2 keyboards. If so, 
disconnect the MIDI OUT from your computer. 
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How do I upgrade the chips in my CMK-2 Classic Keyboard Stack?  
 

To install the chips, first you should back up your current settings using your old version of CMK config. 
Make sure the power is off. 
You need to remove the 2 screws that hold the circuit board to the keyboards. There will be 2 sets of ribbon connectors. 
One set is right at the front and one is further back. Ease both of those off their mounts. 
Look for the chip the same size as the replacement one.  
Note the little semi-circular cutout at one end of the chip and which way it is orientated. 
Ease out the old chip from the socket. 
Gently but firmly seat the new chip in the holes with the semi-circular cutout pointing the correct direction and press 
down until it is flat. 
Reconnect both sets of ribbon cables. 
Replace the screws. 
Repeat this with each of the CMK-2 keyboards. 
Once you have replaced the chips, you can connect the two older keyboards together and load in the old backup with the 
new CMK config.  
Remember to plug in the MIDI IN and OUT into the computer while configuring. 
Then you can hook all the keyboards together and use the "Load Configuration from CMK".  
Find the backup file that you saved at the beginning. 
Select the Lightning bolt icon to save the configuration back into the memory of the keyboards. 
Disconnect the MIDI out from the computer and you can start up Hauptwerk.  

 
The lights on my keyboards are blinking whether I am playing or not. 
 

After you do all your channel and piston assignments, click on the Lightning bolt icon at the top of the screen. That will 
load the config into the keyboard memory. Note that to do this you need both MIDI IN and OUT plugged in to the stack 
and connected to the computer. 
Once you have downloaded the config into the memory of the keyboards, if the lights are still blinking, unplug the MIDI 
OUT from the computer. Something in your computer is sending MIDI signals whether you are playing or not. 
It should quit blinking if you unplug the MIDI OUT. Modules and Hauptwerk only need MIDI in. 
If you unplug the computer's MIDI OUT and boot everything up again, you should be able to plug it in again with no 
problems. One of the Windows drivers probably had a problem with the configuration process.  

 
My keyboards do not remember the configuration when I turn the power off . 
 

Sounds like you need to save the configuration into the memory of the keyboards. 
After you do all your channel and piston assignments, click on the Lightning bolt icon at the top of the screen. That will 
load the config into the keyboard memory. Note that to do this you need both MIDI IN and OUT plugged in to the stack 
and connected to the computer. See Figure-8. 

 
What product do I use to MIDIfy my pedalboard? 
 

For the pedalboard, we generally recommend the MKSC-4A, especially if you have magnets on the pedal keys already. 
This is the scanner we use in our pedalboards and we have a pedalboard switch kit to make it easy for those with the 
magnets. It has three swell shoe inputs built into it. If you have our keyboards, the MKSC-4A is not so crucial since each 
one of the keyboards also has one swell shoe input in the back. The MKSC-1A is much easier to wire up than the MKSC-
4A if you have the keyboards with separate switches.  
For pedalboards we can provide two types of scanners that will convert the key presses into MIDI data for your MIDI 
interface. If you wire the pedalboard as an 8x8 matrix (with diodes), you can use our -4A product. If you parallel wire it, 
which means one wire per key with a +12V common wire (A.K.A. a contact rail), you can use our -1A board.  
The difference between parallel and matrix wiring is this:  
Parallel wiring uses a single power source (usually +12v) connected to all the keys with one wire coming from each key 
contact and results in 62 wires from a 61-note keyboard.  
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Matrix wiring groups the keys into an 8x8 matrix. Think of it like a checker board with 8 squares on each side. To find 
the address of any square, there is a row and a column that is unique to that square.  The result gives you 16 wires out (8 
for each side of the matrix) instead of 62.  
It sounds like you will be using a parallel scanner. You will need one scanner for each keyboard or pedalboard. 
Since the pedalboard will only use up to 32 of the inputs, you can use the leftover inputs for pistons, tabs or toe studs if  
you are going to use Hauptwerk. 

 
How do I configure the swell shoes to work with Hauptwerk?  

 
If you have the swell shoes plugged into the pedalboard, you need to configure them via the pedalboard. See pg. 8 in the 
pedalboard manual.  
Shoes are considered "Analog Inputs". You need to set the output of the shoes to the appropriate channel, AND message 
before you will see any output data. See the output to send a volume control change (control message 07). 
If you have the shoes plugged into the keyboards themselves, then you can use the CMK Config software to configure 
them. 
If you are using a PC you can check the output from your MIDI gear by installing MIDI Medic from the Classic Organ 
Works CD. 
If you are using a Mac, you can download MIDI Monitor from the internet. It is free and does mostly the same things. 
If you get the correct data coming out of the MIDI gear (confirmed by MIDI medic) and then it doesn't work in 
Hauptwerk, then it is a Hauptwerk config issue. 
 
Here are some Typical Swell Shoe sequences: 
Note: 
After Pressing the programming push-button you have about 10-15 seconds to complete each sequence.  
You need to press the push-button to start programming each sequence as well.  
You will not see the MIDI data from any analog input until both the channel and the control message sequences have 
been completed for that analog input. 
Analog 0 (closest to the black stripe) 
F#1 F#2 C1 A#2 Channel 1 
F#1 D#2 E1 A#2 MIDI Volume Control (07) 
Analog 1 
G#1 F#2 D1 A#2 Channel 2 
G#1 D#2 E1 A#2 MIDI Volume Control (07) 
Analog 2 
A#1 F#2 E1 A#2 Channel 2 
A#1 D#2 E1 A#2 MIDI Volume Control (07)  

 
 
Classic Organ Works has a free MIDI diagnosis program named MIDI Medic. This will let you see the 
content of any MIDI message to check its parameters. You can also send messages to test the MIDI 
devices. Just download it from the website:  
 

http://www.organworks.com/Web/products/products.asp?productid=89&categoryid=18&category=Software 
 
See next page for brief details. MIDI Monitor is a similar free program for the MacIntosh. 
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MIDI MEDIC 
 

 
 

 
Description 

 
MIDI Medic is a diagnostic tool for Microsoft Windows that allows one to diagnose MIDI problems.  
 
It captures, or “dumps”, MIDI data to your screen and is useful for confirming that MIDI equipment 
is, in fact, sending the messages that a given program is expecting. 
 
MIDI Medic captures and displays MIDI data being sent to the selected MIDI port on your PC.  
 
The software also allows the user to send MIDI messages out of a selected MIDI port. 
 

Features 
Capable of filtering incoming messages by channel or by message type 
Can save captured data as a text file 
 
Applications 
To check for the presence of MIDI signals. 
To display the content of each message. 
To diagnose MIDI problems. 

 


